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16.1 INTRODUCTION
Contractors have been looking for, and adopting, many tools and methods to cut costs and
improve profit margins. Contractors who construct ODOT’s highways are increasingly using
automated machine guidance in order to provide more cost-efficient projects. An important
prerequisite for many of these new tools and methods is a complete and accurate digital design
package prior to construction. Information provided in this chapter will guide designers in
producing more precise designs to support these methods. Detailed, accurate original ground
surveys are necessary for a successful project.
ODOT has established a long-term vision to generate construction documents from electronic
data (vs. paper sheets). ODOT’s Engineering Automation White Paper presents key concepts
for a 25-year vision across project delivery disciplines (surveyors, designers, inspectors,
contractors, etc). The initial short-term goals of the 25-year vision are summarized in the
Construction Machine Automation Plan and include a vision of moving ODOT forward from
paper-based to electronic data-based platforms for bidding and construction.
The purpose of Chapter 16 is to provide guidance for delivery of roadway digital design
elements (including 3D design) for use by contractors and the Agency’s construction
administration staff on State Highway projects. Digital design packages provided by the
roadway designer (Agency or consultant) include the eBIDS Handoff package (used as a
reference document during the bidding phase), and the Construction Survey Handoff package
(used by the PM’s staff and the contractor’s surveyor during the construction phase).
Checklists that describe the data to be included in the Handoff packages, as well as examples of
the package data, are provided in Appendix M (Digital Design Packages). Designers who
deliver digital roadway design products may also refer to Appendix N (Digital Design Quality
Control), which is included as a supplemental resource to assist roadway designers/construction
coordinators who provide independent quality control reviews of digital design packages at
key project development milestones.
The eBIDS Handoff package and Construction Survey Handoff package are required on all state
and federal aid STIP roadway projects designed to 3R or 4R standards that are accepted by the
Office of Project Letting (OPL). This requirement applies to projects located on the state system,
regardless if delivery is from Agency, Local Agency or Consultant forces. Any exception to this
requirement must be approved by the Region Roadway Manager (in writing) no later than the
Advance Plans project delivery milestone, as described in Section 16.2.1.
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16.2 DIGITAL DESIGN ELEMENTS
This section provides a summary of ODOT’s required software, required digital deliverable file
formats, and required content to be included in the digital design packages described in Section
16.4. Additional information regarding file formats and content is provided in Section 16.4.

16.2.1

WHICH PROJECTS REQUIRE DIGITAL DESIGN?

According to ODOT’s 2012 Highway Design Manual, Section 1.3, roadway design is performed
in accordance with one of four project design standards:
•

ODOT 4R/New Standards – generally applies to modernization projects such as
interchanges, intersection improvements, new alignments, etc.

•

ODOT 3R Standards – generally applies to resurfacing, restoration, and
rehabilitation (3R) projects and may include safety enhancements, superelevation
corrections, etc.

•

ODOT 1R Standards – generally applies to resurfacing (1R) and includes single-lift
pavement applications

•

ODOT Single-Function (SF) Standards – generally applies to a limited-scope
modernization-type improvement (4R), such as a guardrail upgrade

Digital design data packages (see Section 16.2.4) shall be prepared for projects designed to 3R or
4R standards, regardless if delivery is from Agency or consultant forces. They may also be
appropriate for 1R or SF projects that include designed grading work.
Preparation of the digital design data package may not be appropriate for some projects due to
various constraints such as schedule, scope, and/or budget. The responsible Region Roadway
Manager (RRM) may approve an exception to the requirement for the eBIDS handoff package
upon written request prior to the Advance Plans milestone.

16.2.2

DIGITAL DESIGN ENGINEERING SOFTWARE

In order to provide digital design packages for construction projects, ODOT roadway designers
use the single design software platform described below:
•

MicroStation (Bentley suite of products) – Computer Aided Drafting (CAD) software
creates line drawings that are used to produce paper plan sheets. This software is
the platform for InRoads.
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InRoads (Bentley suite of products) – This software creates the digital model of the
existing and proposed surfaces. Topographic mapping from the surveyors is
imported into InRoads before the designer begins their work.

DIGITAL FILE FORMATS

There are two major downstream users of design data: ODOT’s construction Project Managers’
offices (internal users) and contractors (external users). The file formats provided should
accommodate the needs of both groups of major downstream users. Because internal users
have the same tools as roadway designers, they can access the MicroStation and InRoads files
directly. For our external users, it is necessary to also generate reports and export data in
formats useful to those users. Refer to Section 16.4 for additional detail on required digital data
and content.
All designers (consultant and ODOT) are required to provide data for projects designed to 3R or
4R standards in the formats described in Section A below. In addition to the data in Section A,
ODOT designers are required (and consultant designers are encouraged) to provide the data
described in Section B. Note: the sections below designate approved file formats only. Actual
delivery requirements for bid are shown in the eBIDS Handoff Package Checklist.
Requirements for construction are determined through collaboration with the PM’s office.
Please refer to Section 16.4 and Appendix M for additional information.
A.

FILE FORMATS FOR DIGITAL DATA FROM CONSULTANT AND ODOT
DESIGNERS:
•

CAD (graphics) – MicroStation design file (.dgn)

•

Horizontal control coordinates – ASCII/text (.txt)

•

Elevations – ASCII/text (.txt)

•

Horizontal and vertical alignments – horizontal and vertical alignment text (.txt);
InRoads Geometry report (.xml or .html); LandXML (.xml) alignment; MicroStation
design file (.dgn)

•

Superelevation – superelevation diagram in MicroStation design file (.dgn); InRoads
HTML (.html) report; text (.txt)

•

1Existing

•

1Proposed

ground surface – LandXML surface; InRoads DTM (.dtm); MicroStation
design file (.dgn)

surfaces – LandXML surface (.xml); InRoads DTM (.dtm); MicroStation
design file (.dgn)

1 Although add-ons for exporting certain proprietary files (Topcon, Trimble, Leica, etc.) are available using InRoads,

only these file formats are used in order to provide a consistent product to contractors.
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•

Cross section data – MicroStation design file (.dgn); Adobe PDF; InRoads Cross
section report (.xml and .html); Excel spreadsheet (.xls or .xlsx); text (.txt)

•

Quantities –
•

Volume – InRoads volume report (.xml or .html); MicroStation design file
(.dgn); text (.txt); Excel spreadsheet (.xls or .xlsx)

•

Area – InRoads surface area report (.txt); MicroStation design file (.dgn); text
(.txt); Excel spreadsheet (.xls or .xlsx)

•

Linear – MicroStation design file (.dgn); text (.txt); Excel spreadsheet (.xls or
.xlsx)

FILE FORMATS FOR ADDITIONAL DIGITAL DATA FROM ODOT DESIGNERS:
•

Alignments – InRoads geometry project (.alg)

•

Templates – InRoads template library (.itl)

•

Corridor definitions – InRoads roadway design definition file (.ird)

•

InRoads preferences – InRoads preference file (.xin)

•

Drainage – InRoads drainage database file (.sdb)

DIGITAL DESIGN PACKAGES

Digital design data described in Section 16.2.3 and Section 16.4 is compiled into two separate
digital design packages. Appendix M includes checklists that summarize the data to be
included in the two packages. Figure M-1 provides a schedule showing the approximate
durations needed for developing the digital design packages.
The eBIDS Handoff package is the first digital design package. The eBIDS Handoff data is
submitted to the ODOT Project Leader no later than 1 week prior to the Project Advertisement
milestone. The ODOT Project Leader uploads this data to eBIDS as a reference document at the
time of Project Advertisement to assist contractors in the bidding process. The data included in
the eBIDS Handoff package is not intended for use in project construction.
The Construction Survey Handoff package is the second digital design package. The
Construction Survey Handoff data is due 30 days after Bid Opening and generally coincides
with Notice to Proceed for the contractor. The Construction Survey Handoff package is
submitted to the ODOT construction PM’s office assigned to the project. The provided data
communicates the design information needed for the administration of the construction
contract. The data included in the Construction Survey Handoff package supersedes the data in
the eBIDS Handoff package.
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16.3 INROADS 3-DIMENSIONAL DIGITAL
DESIGN PROCESS
Roadway designers currently provide 3D Digital Design elements to Construction when they
hand off their InRoads proposed surface DTM files. This current practice is expanded upon to
produce the digital design packages shown in Appendix M. Displaying the surface triangles
and component features from the DTM into a 3D MicroStation file provides 3D elements that
can be viewed and rotated in virtual space.

Figure 16–1: Display of Components with Existing Ground Contours and Triangles
The purpose of this section is to expand upon the basic use of InRoads that every designer
should know. It is presumed that the designer knows the basics of generating an InRoads
model. This includes creating alignments, templates and corridors; applying point controls and
parametric constraints; adding superelevation; and reviewing the results. General reference
information on InRoads usage at ODOT is available in the ODOT InRoads V8i User Guide,
latest edition.
Evolving construction technologies, such as automated machine guidance (AMG) grading, are
being implemented by contractors at an increasing rate for not only large projects, but small
ones as well. This will inevitably expand beyond grading work to automated machine
guidance pavement grinding and slip-form extrusion of curbs and other concrete features. This
evolution necessitates the need for more robust modeling of the design than was typically
required in the past.
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The following outlines the considerations and added modeling effort required to reach this new
level. Most of this process involves the settings and design tools located within the InRoads
Roadway Designer. The designer should be aware, however, that use of the Roadway Designer
by itself may not provide a complete modeling solution. ODOT’s 3D Roadway Design
Committee (3D RDC) and Technical Services have collaborated to provide 3D Advanced
Roadway Design Modules to assist the designer in developing skills required to perform the
detailed models necessary to meet the needs of rapidly evolving construction technologies.
These “Just-in-Time” training labs are available on ODOT’s Engineering Automation and
Support Team (EAST) training website.

16.3.1

TEMPLATE CONSIDERATIONS

Templates are the “building blocks” of the design model. They define the general geometry
and relationships between features. Proper template creation and usage is key to producing a
detailed and accurate model. The geometry and relationships assigned within the template can
be modified using point controls, parametric constraints and end condition exceptions. Users
less familiar with proper template and component construction should consult the ODOT
Inroads V8i User Guide and other training resources for additional information.
It is important to consider all the features that may be needed by Construction when creating
templates for the model. An example is lane location features when using one template to
represent a two lane, three lane, and four lane section in conjunction with parametric
constraints or point controls to change the roadway width. If the additional lane location points
(TL, TL1, TL2, etc.) are not included in the template, the result is a model that lacks all the lane
location features needed for layout purposes.
One alternative to using multiple templates in this example is to include all the lane location
points in the template, ensuring they are spaced a minimum of 0.001’ apart through the
template geometry, parametric widths, or point control offset values. This nominal offset value
avoids triangulation errors caused by crossing breakline features that could result from the use
of zero values. This alternative, however, requires additional consideration for reporting the
lane location points.
The reporting options are:
1)

Include all points even though they are offset by only 0.001’

2)

Limit the station range of the display for additional lane location points in the cross
sections to just the widened areas – if a feature is not displayed at a cross section
station, it will not appear in the report at that station, or

3)

Edit the resulting report and remove coincident lane location points.

The designer should consult with Construction on which options are acceptable.
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A second alternative is to drape the lane locations into the design surface afterwards. When
using this method, be sure to use the correct feature style when importing the graphics into the
surface. This method is similar to that described in Section 16.3.5.

16.3.1.1

TEMPLATE DROPS

Adequate template drops (or processing stations) are essential for detailed modeling. Because
InRoads simply connects points between template drops or processing stations, the design
surface displayed on any cross sections cut between drops will only represent an interpolation
between them. Consequently, if the locations of any changes occurring in between template
drops are not included in the processing, the inaccurately modeled surface will yield incorrect
information on the cross sections and grade reports.
In addition to template drops at regular intervals (suggested intervals are 25’, 5’, or 1’
depending on the geometry), they should also occur at: the beginning and ending of tapers; end
condition transition points; approaches; culvert end points; signal pole locations; and wherever
else needed to produce an accurate model and cross section information. This is accomplished
by adding another drop in the Template Drops dialog box, or by using either Key Stations or
Event Points to add specific processing stations.
The Key Stations dialog box is found in the Roadway Designer (Corridor > Key Stations). A
note of caution when using Key Stations: it is easy to inadvertently add them by keying in a
specific station while in the Roadway Designer. Event Points, however, are stored with their
respective horizontal and vertical alignments. The dialog box is found under Geometry >
Horizontal Curve Set > Events. When Key Stations or Event Points are used, be sure to toggle
them on in the Cross Sections dialog box when creating cross sections (see 16.4.4.1 for further
information on cross section generation).
An extra template drop just prior to the start of a new template (0.01’ or 0.001’ apart) can help to
properly model abrupt changes in the roadway cross section.

Note: When creating cross sections, enabling the Critical Sections toggles for
Superelevation Event Stations, Template Entries, Key Stations, or External
Control Points (see Figure 16–18) results in cross sections for all the toggled
critical section choices along the specified alignment relative to all corridors that
use the same alignment. This may result in undesirable extra cross section
locations for a given corridor model. A suggested workaround for this InRoads
functionality is on the EAST website Tips & Workflows page under InRoads >
Evaluation.
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POINT NAMING

As mentioned previously, the quality of grade reports produced for Construction is dependent
on the quality of the model. To ensure good grade report information, it is important to use the
appropriate point name from the ODOT template library for all the points on the components.
An important benefit of selecting the proper point name from the library is that it sets the
correct surface feature style for the point as well. When it is necessary to create a new point
name for custom components, it should be logical and follow the general point naming
convention used in the template library. Be sure to choose an appropriate surface feature style
as well. Keep in mind that the point names show up on the grade report, so the proper use of
point names for the various components, left/right affixes, and directional notation is
important.

Figure 16–2: Sample Template from ODOT Template Library

16.3.2

INROADS SETTINGS

Many InRoads settings affect how the model is processed. Often, the default settings are
satisfactory. However, producing a more detailed surface model requires changes to these
default settings. The settings explained below enable InRoads to more accurately model the
surface, especially in areas of curvature. They also aid in the visualization of the model in
MicroStation. The designer should verify the settings before generating a surface.
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CHORD HEIGHT TOLERANCES

Chord height tolerances are used by InRoads when densifying curves during surface creation.
The tolerances are defined in Project Options (File > Options) under the Tolerances tab. A
horizontal chord height tolerance of 0.01’ and vertical chord height tolerance of 0.02’ (enter 0.2’
in the data field) 2 are currently recommended.

2 Note of caution: At the time of writing, InRoads Roadway Designer applies the vertical chord height tolerance

incorrectly. Roadway Designer divides the chord height tolerance specified in the Project Options dialog by 10. A
specified chord height tolerance of 0.2’ will be treated as 0.02’ by Roadway Designer.
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ROADWAY DESIGNER OPTIONS

These settings are found under Modeler > Roadway Designer > Tools > Options. It is
recommended that the designer check on all the boxes under Include Critical Sections.
Enabling processing at these locations produces a more accurate model by preventing InRoads
from simply interpolating between the specified template drop intervals of the various corridor
templates.

When enabling the External Control Points toggle to add processing stations to coincide with
point controls or parametric constraints, it should be noted that processed stations will occur at
all vertices in the alignments or features being used for point controls. This may result in a
significant number of additional template drops depending on the number of vertices.

16.3.2.3

SURFACE CREATION SETTINGS

The Create Surface dialog box (Modeler > Roadway Designer > Corridor > Create Surface)
affects how InRoads generates a DTM surface from the Roadway Designer. Both check boxes
under the Densify using Chord Height Tolerance section should be enabled. This tells
InRoads to add additional processing stations in areas of horizontal and vertical curvature
using the chord height tolerance values set previously. Enabling the Add Transverse Features
§ 16.3 - Inroads 3-Dimensional Digital Design Process
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box improves the surface output and makes for easier visualization of the model in 3D.
Although the Display in Plan View toggle for features is off in the example shown below, the
features should eventually be displayed in MicroStation to help review the model’s accuracy.
This can be accomplished by either using the toggle when creating the surface, or through the
Surface Menu (Surface > View Surface > Features or Surface > Update 3-D/Plan Surface
Display) after the surface is created.
The Clipping Options feature is used when generating a single surface from multiple corridors to
remove areas of overlap. For more information on the use of these options, please refer to the
InRoads help file.
After generating a design surface and saving for the first time, be sure to check on the Use
Features Only toggle on the Surface Properties Advanced tab. This ensures that the surface
displays correctly in cross section by forcing the surface data line to connect between
longitudinal breakline features in the modeled surface, as opposed to following the surface
triangles. While this should typically be toggled on for design surfaces, it should be toggled off
for existing (original ground) surfaces. This is also a good time to set the desired surface
symbology to display in cross sections and profiles. Appropriate design surface symbologies
begin with “DTM_” followed by the surface type and MicroStation color table number.
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CORRIDOR MATCHING

When multiple corridors are used to model a project, it is important for the designer to check
for gaps between adjoining surfaces. A good way to check for this is to display the triangles of
the surfaces in a 3D MicroStation model and rotate the view to ensure the surfaces match well
vertically (see Figure 16–3 and Figure 16–4 below). InRoads will connect adjoining surfaces
when merging surfaces. While this may sufficiently resolve gaps horizontally, any vertical gap
problems will be carried into the merged surface. If problematic gaps are identified, they will
need to be resolved using point controls, target aliasing or other methods.
Another way to ensure corridors match is to compare feature point offsets and elevations in the
Cross Section View of Roadway Designer at the corresponding station locations of adjoining
corridors before surface creation.
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Figure 16–3: Top View of Adjacent Corridors

Figure 16–4: Rotated View - Vertical Gap Problem Between Corridors
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DETAILED MODELING

Increased implementation of technological advancements in construction such as automated
machine guidance is becoming the new standard. Maximizing the utilization of this technology
requires more detailed digital models than produced in the past. Instead of “letting the
contractor figure it out”, designers need to do the work up front and “virtually construct” their
designs. This doesn’t just simply make it easier for the contractor, it helps designers find and
correct problems before they get to construction and result in costly change orders.
The following topics reflect areas that have not been thoroughly modeled (or not at all) in the
past. To support this detailed modeling effort, 3D Advanced Roadway Design “Just-in-Time”
training modules are available to assist designers in creating more accurate and detailed
models. They are available on the EAST website and cover most of the topics discussed below.

16.3.4.1

GUARDRAIL

An example of detailed modeling not done regularly is guardrail terminals and their
corresponding tapers. The designer should build into the model the appropriate tapers for
pavement and rock shoulder, and any corresponding embankment widening for all guardrail
terminals. It is also beneficial to model the actual guardrail location as well, especially when it
deviates from the standard template location. In the case of parabolic terminals, modeling the
proper location is most easily accomplished using point controls in conjunction with a design
surface that only includes features for modeling control purposes (import a graphic of the
terminal into the design control surface as described in Section 16.3.5). Refer to Module 10 for
additional information on terminal modeling.

16.3.4.2

BARRIER

Modeling concrete barrier is not necessary for delivery purposes at this time. However,
modeling the barrier as closely as possible to the intended design can be a great tool in
evaluating sight distance. It also provides a good visual display of the proposed design that
may help identify problems not apparent in a 2D representation.
If the designer chooses to evaluate sight distance with the InRoads Roadway Visibility tool
(Evaluation > Sight Visibility > Roadway Visibility), the proposed surface will need to contain
barrier that is triangulated. The default setting for this component is “exclude from
triangulation”. Consequently, if this setting is changed in the template for sight distance
evaluation purposes, be sure to change it back to its original setting before generating final
surfaces for construction.
Module 6 provides additional detail on this topic.

§ 16.3 - Inroads 3-Dimensional Digital Design Process

16-14

2012 ODOT Highway Design Manual

16.3.4.3

3D Roadway Design

GORES

Ramp gores are typically modeled using a combination of point controls and template design.
Generally, the edge of the mainline surface is used as a point control for the adjoining edge of
the ramp surface. Parent-child relationships on end condition components can be used to
develop the surface in the non-paved area of the gore.
The Vertical Gore tool can be used to assist in establishing a ramp profile that will reasonably
match the mainline profile. More information on the use of the tool can be found in the InRoads
help file. It is also demonstrated in Module 12, along with other modeling guidance.

16.3.4.4

ABUTMENTS

The roadway designer should work closely with the bridge designer to model the abutments as
intended. Although the exact geometry of bridge features such as wingwalls will not typically
be modeled by the roadway designer, suitable modeling of slope paving or vertical abutments
is needed to quantify excavation requirements within the roadway envelope. Refer to Module 8
for additional information.

16.3.4.5

RETAINING WALLS

Modeling retaining walls with a project can be very beneficial. It helps ensure a constructible
design and that the structural excavation limits do not extend beyond the right-of-way or other
limitation. The roadway designer should work closely with the geotechnical designer to
produce an accurate model. Be sure to assign the “MAT-*” style to any wall components in the
templates to ensure that the wall displays properly in the cross sections. Additional
information is provided in Module 7.

16.3.4.6

INTERSECTIONS

There is no “easy way” to model an intersection. Modeling an intersection is an iterative
process that will take time. Designers unfamiliar with this process are directed to Module 13, as
well as seeking input from other experienced designers.

16.3.4.7

SIDEWALK RAMPS

Sidewalk ramps are typically constructed to ODOT standard drawings, which define required
slopes and dimensions that comply with Americans with Disabilities Act (ADA) standards.
These small-scale features are built by hand and not machine-controlled. Consequently, there is
no requirement to model them. The design effort required versus the benefit to the Agency
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16-15

2012 ODOT Highway Design Manual

3D Roadway Design

may not be favorable. However, designers are encouraged to use the tools available in
MicroStation and InRoads to assist in the design of ADA-compliant sidewalk ramps to
adequately determine impacts to the project footprint. In instances where a non-standard
detailed design is required due to site conditions, a 3D layout of the ramp in MicroStation is
often beneficial. The 3D graphics can then be imported into InRoads as features and
triangulated into a surface in situations where it is deemed important for construction purposes.
Alternatively, the features can be created directly using InRoads Surface tools.
The latest version of InRoads (not yet adopted by ODOT) uses 3D civil cells that are “parametric
objects”. These objects retain intelligence in how they were created and what they are attached
to. They should allow for more efficient incorporation of sidewalk ramps and similar features
into our design models in the future.

16.3.4.8

APPROACHES

Approaches and non-sidewalk driveways that have designed horizontal and vertical
alignments should be fully modeled and included in the delivery package. Sidewalk driveway
approaches, however, are similar to sidewalk ramps in terms of benefit versus modeling effort.
As such, they are not required to model at this time. Designers are encouraged to include them
in their finish grade models as time allows. Since the modeling of most sidewalk driveway
approach types is accomplished using surface editing tools along with features from the
corridor model (as shown in Module 9), it is recommended to wait until the modeling is
“complete” to create the driveway approach features. Otherwise, the approach may need to be
redone if the “parent” features change because of a corridor update.
Although a minor approach may not necessitate detailed modeling from the perspective of the
roadway work, it may for other reasons. Culvert pipes under minor approaches may warrant
detailed modeling of the approach and ditch line to ensure minimum cover requirements or
hydraulic capacity needs are met.

16.3.4.9

ISLANDS & TRAFFIC SEPARATORS

Longitudinal raised median islands and traffic separators should generally be incorporated into
the modeling through template components. Modeling details such as the radiused ends of the
islands is not required with the currently adopted version of InRoads.
Modeling accessible route islands is similar to sidewalk ramps as discussed previously, and is
not required at this time.
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GRAPHICAL ELEMENTS TO FEATURES

It is often useful to incorporate features into a surface, such as right-of-way or wetland
boundaries, so that their locations can be displayed in the cross sections. This is especially
important to ensure that the project footprint does not extend beyond these boundaries. In
order for these features (typically originating from 2D graphics) to display in cross section,
elevation information must be added during the surface import process. This comes from
draping the graphical element(s) against a defined surface.
The following features are recommended for inclusion in a design surface and displayed in the
cross sections where applicable:
•

Right-of-way (permanent and temporary)

•

Easements

•

Wetland boundaries

Adding these features is typically done through the Import command (File > Import > Surface)
under the From Graphics tab as shown below. For the features mentioned above, draping the
elements against the existing ground surface is typically the most appropriate choice since it is
unlikely to change during the design process. Be sure to enable the Exclude from
Triangulation box. It is recommended that these features be saved into a separate design
surface named for this purpose, such as “keynu_boundaries.dtm”, “keynu_ROW.dtm”,
“keynu_2Dfeatures.dtm”, etc., where “keynu” is replaced with the 5-digit project key number.
Remember to exclude spaces (use underscore character instead) and use no more than 63
characters when naming files or folders (a through z, A through Z, 0 through 9), as the use of
special characters can be problematic for the operating system and many types of software.
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Converting graphical elements into features is also a very useful tool in modeling, especially for
point controls. The features should be imported into a surface named “keynu_control.dtm” (see
previous paragraph for naming convention guidelines) that is not triangulated and only
includes features used for point controls. Be sure to assign the Point Type to “Breakline” as
shown above. When features control points vertically, the designer will need to determine the
appropriate way to assign elevation information to the features. As opposed to simply draping
against a surface, the graphics may instead need to be drawn at the desired elevations in a 3D
MicroStation file prior to import. In this case, be sure to choose “Use Element Elevations” in the
Elevations drop-down list. Module 3 provides additional detail on this topic.

16.3.6

MODEL REVIEW

It is important for the designer to check the model for accuracy. All of the surface features
should be displayed in Top View (assuming a 3D MicroStation model) and checked against the
“flat” MicroStation linework. This will show any discrepancies between the intended design
and the InRoads modeling. Components, features and surface triangles should also be
displayed in a 3D model and viewed from many angles to look for problems or discrepancies
§ 16.3 - Inroads 3-Dimensional Digital Design Process
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between adjoining surfaces. Be aware that even when components and features display as
intended, the surface can still triangulate incorrectly. Often times, triangulation errors will
occur at template transition points. Figure 16–5 shows an example of a triangulation error
discovered during 3D surface visualization.
When displaying surface triangles for
visualization, be sure to toggle on the Mesh box before applying the View Triangles command.
Enabling this toggle increases the display speed by treating the entire surface as one mesh
element as opposed to individual triangles.
Displaying contours of the surface is very helpful in identifying triangulation problems and
corridor discrepancies. Using a dense interval, such as 0.25’ or less, will reveal problem areas.
Rendering surfaces with the built-in MicroStation functionality can also assist in the
visualization and review process. This is easily accomplished by changing the Display Style
through the Presentation Group in the View Attributes dialog box. The “Smooth: Shadows”
and “Thematic“ display styles are particularly helpful in highlighting triangulation errors.
Another method of highlighting triangulation errors is exaggerating the vertical scale of the
surface triangles. This is especially effective when used in conjunction with one of the
aforementioned display styles. One way to apply vertical exaggeration is through the Surface
Options (Surface > View Surface > Options) as demonstrated in Module 2. An alternative way
to apply vertical exaggeration is through the MicroStation Data Acquisition tool (Tools > Data
Acquisition). Although this tool is found under the MicroStation menu, it’s an InRoads Civil
Tool that is only available when InRoads is loaded. For more information on the use of this
tool, refer to the InRoads help file under the Civil Tools section.
All computer modeling should be reviewed against the project plans to ensure consistency.
This should be performed by both the designer and another qualified party as part of a quality
control process. Discrepancies between the modeling and the contract plans will cause
confusion and may lead to change orders in construction.

Figure 16–5: Surface Triangulation Error
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SOLIDS AND RENDERING OF 3D DIGITAL DATA

Although not required, designers are encouraged to create renderings of solids and/or roadway
prisms to communicate complicated concepts or to help identify and resolve conflicts during
the design phase before reaching construction.
Solids are 3-dimensional representations of physical project components. Examples are pipes
(as shown below), footings, structures, and poles. The use of solids in design can greatly
facilitate the identification and resolution of conflicts, or interference, between constructed
items. As part of the construction documentation, solids can be inventoried for asset
management purposes as well as used for future design reference.
Future incorporation of solids (and the benefits mentioned) is heavily dependent on adoption of
3D modeling by Bridge, Traffic, and Geo/Hydro units. However, Roadway designers
performing hydraulic design using InRoads Storm and Sanitary can enjoy these benefits today.
Workflows for rendering, solids creation and incorporation into final models will be developed
in the future.

Figure 16–6: Manhole and Pipes Shown as 3D Solids
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Figure 16–7: 3D Model Using a Combination of Solids and Roadway Prism
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16.4 REQUIRED CONTENT FOR DIGITAL
DESIGN PACKAGES
The contents of a digital design package will vary with the complexity of the project. Shoulder
widening projects usually require some horizontal and cross section control and would merit a
minimal package. An interchange or urban modernization project requires an extensive
package that includes many alignments and surfaces defining the project. Regardless of project
complexity, some guidelines must be followed in order to reduce the possibility of errors (and
claims) during construction:
•

The design package must contain only the information incorporated in the final
design. Multiple versions or design iterations will create confusion during
construction.

•

The files must follow a consistent naming convention. Files that contain information
related to the project as a whole (e.g., design file, geometry project, corridor
definitions) should be named with the key number. Files related to specific
alignments should incorporate the alignment name as shown on the plans.
Consistent prefixes and/or suffixes may be added to further clarify the purpose of
the file.
There are restrictions on file names imposed by ODOT’s web application
environment. These restrictions are described in Appendix M.

•

The package must be organized logically and consistently. Construction office staff
are usually under tight time constraints; they will need to find the desired files
quickly.

•

The construction Project Manager is the agency’s contact with the contractor. After
bid opening, route all design data through the Project Manager’s office.

The eBIDS Handoff Package Checklist describes the minimum required contents for the eBIDS
Handoff package. The required contents for the Construction Survey Handoff package shall be
determined through negotiation between the designer and construction office staff. No data
from the eBIDS Handoff package should be used for construction. The data in the Construction
Survey Handoff package supersedes all data provided in the eBIDS Handoff package. Designers
shall continue to coordinate with the construction Project Manager’s office throughout the
length of the project to provide additional digital data and reports as needed. Example digital
design handoff checklists are provided in Appendix M for reference.
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INDEX

One of the most important documents, common to all handoff packages, is the index. The index
should include the project data (name, highway, key number, etc.); directory structure; file
names; and file descriptions. Multiple models within design files should be indexed as though
they are files. The index can be a spreadsheet, a narrative, or even an HTML file (similar to a
web page). It can include links to the individual files, or to their locations in the directory
structure. It can reference a file (pdf, dgn, etc.) that graphically shows the geographic locations
of various elements. The designer needs to consider the requirements and resources of the
user(s) when determining the format to use and features to include.
In general, the space available for descriptions in DTM and geometry project files is limited and
may not allow for complete descriptions. The alignment and surface descriptions in the index
should be sufficiently complete to indicate the purpose of the alignments and surfaces.

Figure 16–8: Index in Spreadsheet
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Figure 16–9: Index Contained in Narrative

Figure 16–10: Index in HTML Document with Links to Reports
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ALIGNMENT DATA

The eBIDS Handoff includes alignment data for all alignments shown in the plans. In addition,
the Construction Survey Handoff includes all alignments that define the design or project
constraints. These will include not only the roadway centerlines, but also the R/W centerline;
pipe centerlines; structure centerlines; and alignments used to control the modeling of
roadways. Alignment names shall match the names shown on the contract plans. External
control alignments should have logical names such as the centerline alignment name and a
prefix or suffix describing the control type. Descriptions are required for all alignments. The
ODOT InRoads V8i User Guide provides some assistance indeveloping the alignment data
described here.
The following sections provide examples of formats used to communicate alignment
information to contractors and the construction Project Managers’ offices. These formats are
consistent with those listed in Section 16.2.3. Horizontal and vertical alignment file formats are
comparable.

16.4.2.1

INROADS GEOMETRY PROJECT (.ALG)

This is the easiest format for sharing alignment data between ODOT groups and other InRoads
users. The file should contain only the data necessary to control construction. Primary
alignment names should match those in the plans and all alignments should include
descriptions explaining their purpose. Alignments not used in the final design should be
deleted. Vertical alignments can be easy to miss in this process; the designer should review all
children of horizontal alignments to locate obsolete vertical alignments. The alignments shall
have the appropriate styles assigned.

Figure 16–11: Delete Unused Alignments
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MICROSTATION DESIGN FILE (.DGN)

All of the alignments are displayed in a design file to provide a location index. For the sake of
clarity, external control alignments may be displayed in a separate model. All alignments
should be stationed and identified with labels large enough to be read from a project level view
(i.e., make the labels large). Generally, no other alignment annotation is necessary. Profiles are
required for all horizontal alignments with associated vertical alignments. These can be
displayed in a separate model or design file for clarity.

Figure 16–12: Alignments Displayed in Design File

16.4.2.3

ALIGNMENT REPORTS

Reports for all alignments should be included with the Construction Survey Handoff
documents.
•

Easy to read text reports can be created with the Review Active Alignment tool.
The full alignment option lists every element individually and includes
equations. This option does not show the PI or total deflection for spiraled
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curves – it shows the PIs and deflections separately for each spiral and curve.
Regardless, this is the preferred option. The Review Alignment reports cannot
be readily translated for use by InRoads or other civil programs.

Figure 16–13: Review Active Alignment Report
•

16.4.2.4

A wide variety of reports are available through the XML Reports tool. These
reports can be saved as HTML or text files. Some reports offer the option of
saving as an Excel spreadsheet (.xls), however they are not truly Excel files until
they have been opened in Excel and saved as an Excel workbook (.xls or .xlsx).
Inclusion of the XML source file allows the construction staff to create reports
with the format that best suits their need.

LANDXML FILES

Many civil software packages, as well as many automated machine guidance systems, can use
LandXML files directly. Only primary alignments necessary for construction purposes should
be included with the eBIDS Handoff package.
Caution: LandXML files have the same file name extension as InRoads XML report files. They are not
the same. InRoads provides minimal reporting tools for LandXML files. InRoads XML report files
cannot be used to export/import alignment or surface data.
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Figure 16–14: LandXML Translator for Alignments

16.4.3

SUPERELEVATION DATA

Superelevation diagrams should accompany the profiles for all superelevated alignments. If
requested, superelevation reports can be created from the Roadway Designer.

16.4.4

SURFACE DATA

Include all surfaces that define the project design. This includes not only roadway surfaces, but
also ditches, ponds, bridge ends, and other graded areas. Surfaces that may be considered
subsets of the roadway prism – e.g., aggregate base and subgrade – can be created from the
features generated by Roadway Designer. The following sections provide formats used to

§ 16.4 - Required Content For Digital Design Packages

16-28

2012 ODOT Highway Design Manual

3D Roadway Design

communicate design surface information to contractors and construction Project Managers’
offices. These formats are consistent with those listed in Section 16.2.3.

16.4.4.1

INROADS DIGITAL TERRAIN MODEL (.DTM)

Provide InRoads digital terrain models (.dtm) to the construction Project Manager’s office.
Name surfaces consistently and appropriately. Surfaces related to a specific alignment should
include the name of the alignment, as shown on the plans, in the surface name. Assign
appropriate preferences and symbologies to the surfaces.

16.4.4.2

MICROSTATION FILE (.DGN)

Display all features and triangles in a 3D design file. Other civil design software capable of
reading MicroStation files can import the surface from the design file. Use ODOT’s standard
InRoads preference file in order to comply with drafting standards. The use of multiple design
file models will help in organizing the information. Where more than one surface is displayed
in a single model, label the surfaces.

Figure 16–15: Rotated View of Features and Triangles Displayed in Design File
Ensure that tags are attached to the graphic elements. The tags are helpful to MicroStation
users without access to InRoads, as they contain information about the elements such as
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feature name, style, description, and DTM name. Use multiple files or models where
multiple material layers (e.g., subgrade, base, top of pavement, footing excavations, etc.) are
required.

Figure 16–16: Index of Surface Names and Locations

16.4.4.3

LANDXML FILES

LandXML files can be imported into many other civil design and construction systems. The
“intelligent” data accompanying the surface features is included in the LandXML file. The
InRoads LandXML Translator includes multiple options for the file’s contents; ensure the
appropriate options are selected according to users’ needs. Although several surfaces can be
included in a single file, it is generally not a good practice. The LandXML files are often loaded
directly into surveying or machine guidance systems and multiple surfaces may cause
problems. If unsure of the appropriate options, provide two files for each surface: one file with
triangles and triangulated features only and another with all features. Unless specifically
requested, do not provide a file with triangles only. Some software – InRoads, for instance – does not use
the triangle definitions in the LandXML file and will not triangulate correctly.
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Figure 16–17: LandXML Translator for Surfaces

16.4.5

CROSS SECTION DATA

Include cross sections for all modeled alignments. For the eBIDS Handoff package, cross
sections should be spaced no more than 25’ apart. Cross section interval for the Construction
Survey Handoff should be per agreement with the construction office staff; typically matching
the spacing used for quantity calculations. Label key features in the cross sections for both
handoff packages. In addition, label surfaces where more than one are shown in the same cross
section view.
Include cross sections at key points along alignments:
•

Typical section changes
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•

Alignment cardinal points

•

Drainage facilities

•

Taper ends and angle points

•

Guardrail and barrier limits

•

Centerline of approaches

•

Curb or pavement return points

•

Luminaire and signal pole locations

3D Roadway Design

Other unique project features may necessitate additional cross-section locations.

Figure 16–18: Critical Section Choices for Cross Sections
The last four critical section choices – Superelevation Event Stations; Template Events; Key
Stations; and External Control Points - are extracted from all corridors tied to the source
alignment for the cross sections. Inclusion of external control points, especially, may result in
an excessive number of cross sections. In some cases, the use of events or key stations may
provide better results. Another alternative is to create a custom cross section set that includes
all required locations.
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MICROSTATION DESIGN FILE (.DGN)

Display cross sections in a design file. Large numbers of cross section sets will affect InRoads
performance. For this reason, separate cross section files are often preferable to separate models
within the primary design file. Display the cross sections as large as practical using one of the
sheet layout preferences. Many users will not have the resources to print on large format paper.
11”x17” is a reasonable compromise between large size and convenience. Create PDF files for
the eBIDS Handoff package. The ODOT InRoads V8i User Guide provides some assistance for
creating cross sections.
Generally, cross sections should be displayed with no exaggeration, i.e. the horizontal and
vertical scales are equal. When multiple cross section sets are created, they should be clearly
labeled so they can be identified when viewing the file in a large view. Saved views will help
users locate specific cross section sets.

Figure 16–19: Cross Sections Displayed and Labeled

16.4.5.2

CROSS SECTION REPORTS

Provide cross section reports, which are typically used for staking or checking grades. InRoads
offers a wide variety of cross section reports based on the surfaces displayed in the cross
sections. Specific features can be included as desired. These reports can be saved as HTML or
text files. Some reports offer the option of saving as an Excel spreadsheet (.xls), however they
are not truly Excel files until they have been opened in Excel and saved as an Excel workbook
(.xls or .xlsx). Inclusion of the XML source file allows the construction staff to create reports
with the format that best suits their need. If the available report stylesheets do not provide the
desired information or format, EAST may be able to create a suitable stylesheet. Ensure that
surfaces are clearly identified in reports.
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Note of caution: LandXML files have the same file name extension as InRoads XML report files. They are
not the same. InRoads provides minimal reporting tools for LandXML files. InRoads XML report files
cannot be used to export/import alignment, surface, or cross section data.

Figure 16–20: Cross Section Report Using One of Many Stylesheets

16.4.5.3

LANDXML FILES

Some field inspection software makes use of LandXML cross section files. If these files are
requested, the files can be created through the LandXML translator.

16.4.6

QUANTITIES 3

Include quantity measurements and calculations in the Construction Survey Handoff. InRoads
and MicroStation can be used to measure or calculate quantities for most measured pay items
from surface features displayed in the design file.
1. InRoads can calculate volumes using three different methods: average end area; grid;
and triangles.

3 ODOT does not use the Quantity Manager tool provided with InRoads. For that reason, the measurement tools

included with Quantity Manager are not considered.
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a) Average end area - This is perhaps the most common method to compute roadway
volumes. It will provide a reasonable approximation of earthwork quantities for
linear portions of a project. The InRoads end area volume tool will automatically
compute component quantities, and can develop mass haul diagrams. Reports are
created only if “Create XML Report” is checked.
CAUTION: For site-oriented work, such as intersections, bridge ends, and ponds, volume by
average end area is not valid and can result in significant errors.

Figure 16–21: Create Report When Calculating End-Area Volume
b) Grid – This is a common method to compute volumes over a large site, such as a
quarry. This method can be fairly accurate if the surfaces are smooth. The
InRoads report is a text file including the total volume of the area being
measured.
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Figure 16–22: Grid Volume
c) Triangle – This is the most accurate method to use for either linear or siteoriented work. The InRoads tool allows the evaluation of multiple areas at a
time. Areas can be refined with the use of fences or shapes. InRoads reports the
volume for each area evaluated and, if shapes are used, the sum of the computed
volumes.
The triangle volume tools do not account for components. The triangle volume
tools only compute the volumes between triangulated surfaces. Generally,
surfaces for each layer will need to be created to compute quantities for a
roadway. The surfaces can be created as alternate surfaces when modeling or
new surfaces from the features of the modeled alignment.
d) Triangle by Station – This is an extension of the Triangle Volume tool. As the
name implies, this will provide volumes along a corridor given an alignment,
station interval, and corridor width. The interval used should match the cross
section interval. With the exception of components, the reports from this tool are
the same as the reports for volume by end area. Mass haul diagrams cannot be
generated automatically with this tool.
2. MicroStation can be used to measure the volumes of solids, closed surfaces and closed
meshes. There are no reports available for measurements made with MicroStation’s
measurement tools, so the measured elements should be annotated in the design file any
time this method is used.
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a) InRoads displays components as meshes. If “Stitch Mesh Faces” is checked, the
meshes will be closed allowing measurement of their volumes.
b) Several roadway features - such as walls, footings, bridge components, and backfill –
can be placed as solids or closed surfaces and measured for volume.

Figure 16–23: Stitch Mesh Faces When Displaying Components
3. InRoads can provide planar and true surface area measurements for DTMs and provide
a simple text report of the results. MicroStation can provide true surface area
measurements for either an individual element or all elements in a selection set. No
report is available from MicroStation. Elements measured with either InRoads or
MicroStation should be annotated in a design file. The Area Tools MDL application is
handy for this (key-in: “mdl load atool”).
4. Outside of the Quantity Manager, which is not implemented in the ODOT environment,
InRoads has very few useful tools for measuring linear elements. Surface features can
be displayed in the design file and measured with the MicroStation Measure tools to
provide true or projected lengths of elements. Dimension tools can be used to measure
and annotate individual segments. Items paid on the basis of true length must be
displayed and measured in a 3D file. The respective elements should be annotated in
the design file.
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16.5 DIGITAL DESIGN QUALITY CONTROL
Quality Control of digital design data is a key component of providing high quality, cost
effective and reliable roadway design products. Roadway digital design quality control is the
responsibility of the Region Roadway Manager, and is performed as part of the Region
Roadway Quality Control (QC) process or the Consultant’s QC process (where roadway design
is performed by consultant forces).
It is recommended that an independent review of digital design data be performed by a
qualified roadway designer at the Advance Plans review milestone. For large or complex
projects, it may also be beneficial to provide a review of digital design data at earlier milestones,
such as DAP or Preliminary plans. These earlier reviews should include evaluation of the digital
data elements needed to prepare the eBIDS Handoff package. Comments provided by the
reviewer at the DAP, Preliminary, and/or Advance Plans milestone may then be incorporated
into the digital design prior to creating the draft eBIDS Handoff package. See Appendix N for
additional details regarding quality control of pre-bid roadway digital data.
Once the draft eBIDS Handoff package has been developed, it is recommended that the
reviewer be experienced in interpreting digital data for use in construction. In many cases, the
construction coordinator assigned to administer the project is the most appropriate choice.
Close coordination between the roadway designer and construction coordinator during
development of the eBIDS Handoff package and Construction Survey Handoff package is
essential to creating useful packages. This relationship allows the construction coordinator to
become familiar with and provide input on how the packages are developed. Figure M-1
provides a schedule showing the approximate durations for review of the packages by the
construction coordinator. See Appendix N for additional details regarding quality control of
roadway digital data for the eBIDS Handoff package and Construction Survey Handoff
package.
During the construction administration phase, it may be beneficial to include a “close the loop”
review of data used by the contractor’s surveyor. In cases where automated machine guidance
(AMG) methods are used, the construction coordinator may request that the contractor provide
a LandXML file of the surface data generated using the contractor’s selected software. The
construction coordinator may then import the file into InRoads and verify that any translated
surfaces match those provided by the roadway designer. A future revision to ODOT’s Special
Provision 00305 – Construction Survey Work is expected to establish “close the loop” reviews of
roadway digital data during construction.
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16.6 REFERENCES AND ADDITIONAL
INFORMATION
The following reference information was consulted for Chapter 16.

16.6.1

LANDXML
•

16.6.2

LandXML.org is the official owner of the LandXML standard.
(http://www.landxml.org/)

OTHER STATES
•

Washington State “Tech Notes”
http://www.wsdot.wa.gov/Design/CAE/Technotes.html#InRoads

•

South Dakota CADD Manual
http://www.sddot.com/business/design/forms/cadd/Default.aspx

•

Maine MicroStation/InRoads Manual
http://www.maine.gov/mdot/caddsupport/

•

Connecticut Digital Design Environment
http://www.ct.gov/dot/cwp/view.asp?a=3194&q=483668&PM=1

•

Colorado Design and Construction Project Support
http://www.coloradodot.info/business/designsupport/cadd

16.6.3

OTHER RESOURCES
•

ODOT Engineering Applications Support Team (EAST)
http://www.oregon.gov/ODOT/CS/EAST/Pages/Home.aspx

•

ODOT Geometronics Unit
http://www.oregon.gov/ODOT/HWY/GEOMETRONICS/

•

University of Wisconsin-Madison Construction and Materials Support Center
http://cmsc.engr.wisc.edu/home/reports

•

Federal Highway Administration 3D Engineered Models
https://www.fhwa.dot.gov/construction/3d/

•

Federal Highway Administration e-Construction
https://www.fhwa.dot.gov/construction/econstruction/
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